
 1

Consigli per un corretto utilizzo dell’APRS 
 

(APRS is a registered trademark of APRS Software and Bob Bruninga, WB4APR) 

 

(Automatic Position Reporting Sistem) 
 

  A cura di Marco Bombelli IK2CHZ – K2CHZ    
 
 

(Si auspica la massima diffusione di questo documento purché ne sia citato l’autore) 

 
 

Premessa 
 
Credo sia doveroso ricordare prima di tutto due radioamatori che  hanno fatto 
la storia dell’APRS. Senza di loro tutto questo non sarebbe possibile. 
 
Bob Bruninga WB4APR, ingegnere della US Navy che ha inventato il sistema 
APRS. (http://cadigweb.ew.usna.edu/~bruninga/aprs.html) 
 

 
 

Roger Barker G4IDE, prematuramente scomparso l’8 settembre 2004 poco 
più che cinquantenne. Autore di UI-View. Il migliore e più sviluppato software 
per APRS. Ha lasciato un vuoto incolmabile. 
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Qualche nota per quanto riguarda lo scrivente. Sono nato nel ’59, abito a 
Crema (CR) e sono sposato con Cristiana IW2NVI – KC0QXT che è il mio 
“supporto morale” in tanti momenti della mia attività radio. Lavoro 
all’aeroporto di Linate nel settore operativo. Ho ottenuto il nominativo nel 
1983 ed il mio interesse per la radio è sempre stato orientato verso le HF e la 
caccia al DX. Ho conseguito l’ Honor Roll nel 2005 e nel 2006 ho raggiunto 
l’obiettivo di aver collegato e confermato tutte le entità DXCC. Nei primi anni 
2000 ho sostenuto gli esami radioamatoriali USA ottenendo la Extra Class ed il 
nominativo K2CHZ. Nel 1999 ho iniziato ad interessarmi anche all’ APRS. Sono 
stato una delle primissime stazioni APRS della Lombardia e credo di averlo 
sperimentato un po’ in tutte le modalità: VHF, HF, internet, mobile (auto, 
moto, altro) e su piattaforme diverse: pc desktop, portatili e PDA. Ho 
realizzato le prime mappe per UI-View e dal novembre 2004 ho installato a 
casa mia una stazione meteorologica attiva H24 che trasmettere 
ininterrottamente i dati meteo APRS sia via radio che via internet. Dal 
novembre 2007 ho attivato un server TCP/RF che consente a chi si connette di 
fare APRS senza utilizzare RTX ( ik2chz.no-ip.biz:10152 ). 
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Introduzione 
 
Come è nato l’APRS? 
 
Su come sia nato ho avuto la splendida occasione di chiederlo direttamente al 
suo inventore. Nel maggio 2007 sono finalmente riuscito a realizzare un sogno 
che inseguivo da anni: andare alla più grande manifestazione radioamatoriale 
del mondo a Dayton (Ohio - USA). Già due mesi prima di partire sapevo che la 
sera del venerdì presso il museo dell’Aviazione militare statunitense di Dayton 
(il più grande museo aeronautico del mondo) si sarebbe tenuta la cena del 
TAPR-AMSAT dove è consuetudine che partecipi anche Bob Bruninga WB4APR.  
Un mese prima mi ero già prenotato ed alla cena mi sono presentato a lui e gli 
ho fatto una piccola intervista. Bob è il classico tipo del professore universitario 
americano come si vede in alcuni film. Vestito sempre in modo “casual” con la 
giacca blu sopra il giubbino da pescatore. Mi ha spiegato che una notte in cui 
non riusciva a dormire voleva escogitare qualcosa per le assistenze radio in cui 
si potesse sapere dove si trovavano le stazioni e si è ispirato al suo nominativo 
per il nome: WB4APR Automatic Position Reporting System. I primi 
esperimenti sono dei primi anni ’80 con computer come lo Z80 od il 
Commodore 64 in cui tutto consisteva nell’introdurre a mano le coordinate 
geografiche ricavate da una mappa in base alle posizioni comunicate via voce 
dalle stazioni. Il computer semplicemente le ordinava. Poi apparvero i primo 
GPS e quindi le stazioni comunicavano direttamente le coordinate. In seguito 
con l’avvento del pc in DOS grazie alla potenza di calcolo ed alla capacità 
grafiche incominciò a proiettare la posizione delle stazioni sul mappe molto 
grezze dove a malapena erano tracciati i confini dello stato, le autostrade e le 
statali. Con l’escalation nell’informatica è arrivato tutto il resto. L’APRS è stato 
presentato ufficialmente per la prima volta alla Conferenza sulle Comunicazioni 
Digitali della TAPR/ARRL (Tucson Amateur Packet Radio e Amateur Radio Relay 
Legue) nel 1992. 
Bob mi ha anche spiegato come vede lui l’APRS, cioè un sistema trasversale a 
tutte le tecnologie radioamatoriali che consente un efficace scambio di 
informazioni a livello locale. Proprio per questo motivo lui stesso non condivide 
l’utilizzo  di indirizzamenti di pacchetti con path molto lunghi (più di 3 o 4) in 
quanto in questo modo si forzerebbe l’APRS a fare quello che non può fare e 
per uno scopo che non gli è proprio. 
Bob è stato molto disponibile, il giorno successivo ho seguito una sua 
conferenza molto interessante nell’ambito della “hamvention” con presenti 
circa 300 radioamatori. 
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Come funziona l’APRS? 
 
E’ un sistema di comunicazione che si basa sulla trasmissione di dati digitali  
che trasportano varie informazioni. I dati in formato AX.25 sono normalmente  
trasmessi via radio sulla frequenza 144.800 MHz con portante FM e 
modulazione AFSK 1200 Bd, il cosiddetto packet radio (Bell 103), ma in 
modalità non connessa e quindi senza la certezza che il destinatario riceva 
correttamente ciò che è stato trasmesso, ma proprio per questo motivo si ha 
la diffusione su vasta scala del segnale, il cosiddetto “broadcast”. Più 
precisamente si tratta di pacchetti UI (Unnumbered Information) da qui il 
nome del programma più usato per l’APRS: UI-View. 
 
Ecco come è strutturato un pacchetto AX.25: 
 

 
 
Ecco come è strutturato un pacchetto APRS: 
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L’ APRS serve a trasmettere dati di stazioni fisse, posizione di stazioni in 
movimento, dati meteo di stazioni meteorologiche, messaggi fra due o più 
stazioni, bollettini, avvisi, interrogazioni ad altre stazioni, ritrasmettere dati di 
altre stazioni. 
Tutte queste informazioni sono visualizzabili su mappe geografiche o 
programmi cartografici permettendo così l’immediata visualizzazione della 
posizione delle stazioni. 
Lo scopo principale dell’APRS è soprattutto di fornire informazioni in grandi 
aree locali e questo scambio di informazioni deve avvenire nel modo più 
affidabile possibile. L’APRS non è fatto per tentare le comunicazioni a grande 
distanza o i DX ma per un impiego tattico locale. La sua applicazione ideale è 
in campo di protezione civile. Citando l’inventore dell’ APRS Bob Bruninga 
“APRS is a real-time tactical digital communicatons protocol for exchanging 

information between a large number of stations covering a large (local) area. 

As a multi-user data network, it is quite different from conventional packet 

radio.” 
Da qui il mio intento di dare delle indicazioni sulla configurazione per fare in 
modo che sia davvero affidabile. 
 

Una schermata di UI-View, il software principalmente usato: 
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Cosa serve per fare APRS? 
 

• Per stazione fissa è necessario un computer, un TNC o un modem 
Baycom o anche la sola scheda audio del computer ed un normale RTX 
FM su 144.800 MHz. In alternativa al TNC e al RTX VHF si può utilizzare 
una radio dedicata con modem integrato come il Kenwood TH-D7, TM-
D700, TM-D710 o TS-2000 collegati direttamente al computer tramite 
rs232. 

• Per la stazione mobile serve un GPS con uscita NMEA 0183 rs232 
seriale, un RTX dedicato per APRS come i Kenwood TH-D7, TM-D700, 
TM-D710 oppure un normale RTX FM su 144.800 ed un interfaccia tipo 
Tiny Trak od alcuni tipi di TNC. 

 

                   
                      Kenwood TM-D710                    GPS con uscita NMEA 0183  
 
 

             
 

            Kenwood TH-D7                                  Tiny Trak
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Considerazioni 
 

L’APRS è l’unica specializzazione radioamatoriale in cui tutti siamo sulla stessa 
frequenza (144.800 MHz) e dove si usano computer e apparati che una volta 
configurati continuano a trasmettere senza l’intervento dell’operatore. A 
differenza di tutte le altre attività radioamatoriali non è possibile fare QSY se ci 
sono situazioni che non permettono il normale svolgimento del traffico. Ne 
consegue che è importantissimo OSSERVARE le REGOLE per non penalizzare 
gli altri utenti e per permettere il buon funzionamento della rete. 
Scrivo questi consigli in seguito ad alcune osservazioni fatte in questi anni di 
attività in APRS, dal lungo monitoraggio del traffico e dal chiedermi il perché 
delle cose. Le stazioni attive sono moltissime ormai da anni (circa 300/400 al 
giorno attive contemporaneamente sul territorio italiano). Osservando le 
configurazioni dei vari utenti mi sono reso conto che la prima causa del QRM, e 
quindi della scarsa efficienza del sistema, siamo noi stessi. Per rendersene 
conto basta ascoltare l'audio a 144.800, si sentono molti pacchetti trasmessi 
contemporaneamente, è una collisione continua ed il rapporto fra quanto 
ascoltato e quanto effettivamente è demodulato è bassissimo. 
Premesso che risolvere totalmente il problema è impossibile perché è 
intrinseco nella filosofia di funzionamento dell'APRS, ossia l'essere tutti sulla 
stessa frequenza ed in modalità non connessa, adottando opportuni 
accorgimenti si potrebbe migliorare notevolmente la situazione. 
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Criteri di configurazione 
 
I principali punti su cui intervenire sono cinque: 
 

1. Frequenza di invio del beacon. 
2. Indirizzamento del beacon. 
3. Configurazione digipeater. 
4. Messaggistica 
5. Varie 

  
Capitolo 1: frequenza di invio del beacon. 
 
Il beacon è il messaggio che contiene il nominativo di chi lo invia, la codifica 
dell’icona che identifica il tipo stazione, la posizione ed altre informazioni. E’ 
quello che ci fa apparire sulla mappa degli altri utenti, se ricevuto…   
Molte stazioni inviano il beacon con una frequenza troppo elevata. Questo per 
poca conoscenza dei criteri di funzionamento o, peggio, per “eccesso di voglia 
di visibilità”. Facendo qualche conto risulta evidente che se si invia il  beacon 
ogni 3 minuti e lo stesso viene ripetuto 5, 6 o più volte ed il tempo di 
trasmissione di un pacchetto è di circa 1 secondo, moltiplicandolo per 100 o 
più (numero medio di stazioni presenti in frequenza), vediamo cosa succede: 
UN GRAN CAOS! Teniamo presente poi che quasi tutte le stazioni inviano 
anche lo STATUS TEXT che è a tutti gli effetti un altro beacon, quindi il tutto è 
raddoppiato. 
 
1.1 L’invio del beacon dovrebbe essere configurato secondo la tabella 

seguente. 
 
Tipo di stazione Temporizzazione in minuti 
Stazione fissa normale 20 
Stazione fissa meteo 10 
Stazione mobile in movimento (TM-D700 o TH-D7) 1 o 30 sec. 
Stazione mobile ferma (TM-D700 o TH-D7) 10 
Stazione mobile (Tiny Trak con smart beaconing) Automatico 
Digipeater 25 
Internet 10 

 
1.2 Di seguito una tabella su come impostare la temporizzazione del beacon 

sia in UI-View che in apparati dedicati. 
 

Tipo si software o apparato Menu 
UI-View (stazione fissa) Setup -> Station setup -> Fixed -> 20 -> OK 
UI-View (stazione meteo) Setup -> WX station setup -> Radio -> 10 -> OK 
Stazione fissa (TM-D710) Menu 611 -> METHOD: AUTO – TX INTERVAL 20 
Stazione fissa (TM-D700) Menu 3-D -> 20 min -> OK 
Stazione fissa (TH-D7 G2) Menu 2-D (TX INTERVAL) -> 20 min -> OK 
Stazione fissa (TH-D7 1° ver.) Menu 2-7 (TX INTERVAL) -> 20 min -> OK 
Stazione mobile (TM-D710 v. 2) Menu 611 -> METHOD: SMARTBEACONING 
Stazione mobile (TM-D700) Menu 3-D (TX INTERVAL) -> 30 sec o 1 min -> OK 
Stazione mobile (TH-D7 G2) Menu 2-D (TX INTERVAL) -> 30 sec o 1 min -> OK  
Stazione mobile (TH-D7 1° ver) Menu 2-7 (TX INTERVAL) -> 30 sec o 1 min -> OK 
Tiny Trak Selezionare lo smart beaconing in programmazione 
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Come impostare l’intervallo del beacon in UI-View 

 
 
 

 
 

Come impostare l’intervallo del beacon sul TM-D710 (v. 2) 
 

1.3 Un complemento al beacon è lo Status Text, che invia informazioni 
supplementari al beacon principale del tipo: la stazione più lontana 
ricevuta in diretta, la versione del software in uso od un testo libero a 
scelta. In caso di trasmissione anche dello Status Text questo deve 
essere impostato a non meno di 20 minuti. Di seguito la solita tabella. 
 
Tipo di software o apparato Menu 
UI-View Setup -> Status text -> Interval -> 20 -> OK 
TM-D710 Menu 608 -> impostare testo -> OK 
TM-D700 Menu -> 3-6 -> selezionare -> OK 
TH-D7 G2 Menu -> 2-9 -> selezionare -> OK 
TH-D7 1° ver. Menu -> 2-4 -> selezionare -> OK 
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1.4 Una osservazione per le stazioni mobili. Purtroppo molto spesso chi usa 

apparti dedicati Kenwood si “dimentica” quando si ferma a lungo tempo 
di cambiare la temporizzazione del beacon. Questo comporta un 
intasamento della frequenza con dati sempre uguali. Quando ci si ferma 
a lungo è opportuno impostare la temporizzazione del beacon a non 
meno di 10 minuti. 

 
1.5 Per forzare la trasmissione del beacon a tutte le stazioni presenti in 

frequenza (che utilizzano UI-View) si può usare il comando Action -> 
Query all stations o premere F11. Per forzare invece la trasmissione del 
beacon ad una stazione specifica che si presume possa essere presente 
in frequenza, si può inviargli il messaggio ?APRSP. Un altro malvezzo è il 
continuo invio di messaggi del tipo: “non ti vedo in mappa, fai F9”, oltre 
ad intasare come sempre inutilmente la frequenza è più efficace inviare 
un ?APRSP. Questo ovviamente, specialmente il Query all station va 
usato con molta parsimonia. 
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Capitolo 2: indirizzamento del beacon 
 
Come ha detto l'autore di UI-View Roger Barker G4IDE il digipeating non è una 
scienza esatta. Si tenga sempre presente che si trasmette un pacchetto 
digitale non indirizzato ad una stazione specifica e quindi prende una strada 
qualsiasi, quindi non si può sapere a priori chi lo riceverà e chi lo ripeterà. 
La prima considerazione importante è la distinzione fondamentale fra le 
stazioni normali e quelle ripetitrici, cosiddetti DIGI, abbreviazione di 
digipeater, contrazione di digital repeater (ripetitore numerico). 
Per stazioni normali si intendono i normali utenti operanti da sistemi presidiati 
la cui attività precipua è la trasmissione dei propri dati,  indirizzati ad altri 
utenti sia in diretta che tramite la rete di digi, ed eccezionalmente la 
ritrasmissione di dati di altre stazioni normali. 
Per digi si intendono sistemi automatici normalmente non presidiati il cui scopo 
principale è ritrasmettere dati ricevuti da utenti normali o da altri digi e 
secondariamente l’identificazione di loro stessi. 
Detto questo bisogna stabilire a chi indirizzare il proprio beacon affinché venga 
ripetuto e quindi le informazioni possano superare la normale portata radio 
della nostra stazione. Ogni quanto tempo è trasmesso il beacon 
(temporizzazione) è stato descritto nel capitolo uno, ora vedremo “a chi” 
indirizzare le informazioni. 
 
2.1 La parte più delicata per un buon funzionamento della rete APRS è 

l’indirizzamento del beacon. Non dimentichiamoci che utilizziamo 
stazioni automatiche che provvedono ad inviare il beacon in tempi e 
modalità stabilite dall’utente, una volta memorizzate le impostazioni 
continueranno a trasmettere spesso mai controllate dall’utente. Ne 
consegue che una pessima impostazione genera un eccesso di dati 
nelle rete che moltiplicati per il numero degli utenti crea il collasso 
totale. Come stabilire a chi si indirizza il proprio beacon affinché 
venga ripetuto e quindi vada oltre la portata della propria radio? 
Prima di tutto è necessario distinguere la tipologia di stazione in 
funzione della propria copertura radio, in pratica la grossa distinzione 
è fra stazioni fisse e mobili/portatili. E’ chiaro che una stazione fissa 
ha una portata radio maggiore di una mobile/portatile, di 
conseguenza una stazione fissa può raggiungere più facilmente un 
digi lontano affinché i propri dati vengano ripetuti. Per contro una 
stazione mobile/portatile ha minor copertura radio e quindi necessita 
di “qualcuno” più vicino che possa raccogliere i suoi dati e 
ritrasmetterli ai digi più lontani. Per questo motivo è consigliabile 
utilizzare due indirizzamenti  diversi del beacon. 
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2.2 La filosofia di funzionamento dei digi APRS è a "LIVELLI", che sono 
semplificati nella tabella seguente. 

 
Tipo Livello Utilizzo e destinazione indirizzamento 
RELAY Basso Ripetizione di mezzi mobili ad aree locali o a digi di alto livello  

WIDE 
(obsoleto) 

Alto Ripetizione di stazioni fisse o ritrasmissione delle ripetizione ricevute dai 
RELAY 

WIDEn-n Alto Ripetizione di stazioni fisse o ritrasmissione delle ripetizione ricevute dai 
RELAY con SSID a scalare 

TRACEn-n Alto Ripetizione di stazioni fisse o ritrasmissione delle ripetizione ricevute dai 
RELAY con SSID a scalare con identificazione del digi 

Nota: per n si intende un numero compreso fra 0 e 15 (es. TRACE4-4). 
 

2.3 Una breve ma necessaria spiegazione sul funzionamento del SSID a 
scalare. Ogni qualvolta un pacchetto indirizzato ad un digi con SSID a 
scalare (WIDEn-n o TRACEn-n) viene ripetuto, l’ultimo numero viene 
scalato di una unità. Ad esempio un beacon indirizzato a TRACE3-3 
dopo la prima ripetizione diventerà TRACE3-2, poi TRACE3-1 e 
quando diverrà TRACE3 (non esiste 3-0) non sarà  più ripetuto. 
 

2.4 Molte discussioni e differenti punti di vista sono stati espressi in questi 
anni sull’indirizzamento del beacon. Sostanzialmente si tratta di 
adottare l’indirizzamento a WIDEn-n o TRACEn-n. I sostenitori della 
tesi del WIDEn-n adducono come vantaggio la minor lunghezza del 
pacchetto con tutti i vantaggi facilmente immaginabili, ma questo è 
l’unico punto a favore del WIDEn-n. Il TRACEn-n introduce ad ogni 
ripetizione il nominativo del digi che ha ripetuto l’informazione e 
quindi tutto il pacchetto si allunga. 
 

2.4.1 WIDEn-n. Pro: pacchetto più corto. 
2.4.2 Contro: non si vede il path del pacchetto e quindi non si sa 

quale digi lo hanno ripetuto. Con questo sistema non si può 
stabilire quale digi usare per inviare un messaggio ad una 
stazione che non si riceve in diretta. 

2.4.3 Contro: non si sa quali digi funzionano e quali no. 
2.4.4 Contro: se una stazione non autorizzata si attiva come digi ad 

ampia copertura non si vede. 
2.4.5 Contro: non si possono identificare doppie ripetizione in zone al 

alto numero di digi. 
2.4.6 Contro: non si vedono interessanti fenomeni di propagazione 

del segnale. 
2.4.7 Contro: quando si trasmette la conferma di ricezione di un 

pacchetto (ack) non sapendo da quali digi e’ stato ricevuto il 
messaggio ritrasmette l’ack a digi generici WIDEn-n 
coinvolgendo quindi una gran quantità di digi che interessano 
l’area di pertinenza. 
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2.4.8 TRACEn-n. Contro: pacchetto più lungo, anche se con gli 

accorgimenti descritti in seguito si può contenere la lunghezza. 
2.4.9 Pro: si vede il path del pacchetto e quindi si vede quali digi lo 

hanno ripetuto. Importante per stabilire quale digi usare per 
inviare un  messaggio ad una stazione che non si riceve in 
diretta. 

2.4.10 Pro: si vede quali digi funzionano e quali no. 
2.4.11 Pro: se una stazione non autorizzata si attiva come digi ad 

ampia copertura si vede. 
2.4.12 Pro: si vedono eventuali doppie ripetizioni. 
2.4.13 Pro: si vedono i fenomeni di propagazione. 
2.4.14 Pro: quando si trasmette la conferma di ricezione di un 

pacchetto (ack) percorre in senso contrario la strada "tracciata" 
dal proprio beacon senza interessare tutti gli altri digipeaters 
come farebbe il WIDEn-n. 

2.4.15 Pro: in un contesto come quello italiano dove è diffusa la 
pessima abitudine da parte di alcuni utenti APRS di attivare e 
disattivare la propria stazione come digi, l’utilizzo del TRACEn-n 
permetterebbe un miglior controllo della situazione.  
 

2.5 Dopo molte osservazioni fatte, credo che un buon compromesso fra 
un pacchetto non eccessivamente lungo e tutti i vantaggi dell’utilizzo 
del TRACEn-n sia l’adottare un TRACE con poche ripetizioni, con un 
massimo di 4 ripetizioni. Ribadisco che l’obbiettivo dell’APRS è quello 
di una buona copertura e affidabilità delle informazioni trasmesse in 
grandi aree locali, non fare DX (vedi introduzione). Un indirizzamento 
eccessivamente lungo dei pacchetti (superiore a 3 o 4 ripetizioni) non 
aumenta la distanza coperta. E’ risaputo ed è una regola basilare 
dell’informatica, che più il pacchetto diventa lungo e più diventa 
corruttibile e quindi non arriva a destinazione integro. Quando si 
trasmette un pacchetto indirizzato a più ripetizioni si ha un ottima 
probabilità di essere ritrasmessi una prima volta, una buona 
probabilità di essere ritrasmessi una seconda volta, una discreta 
probabilità di essere ritrasmessi una terza volta e così via fino a 
quando è praticamente impossibile che siano ripetuti tutti gli n salti 
che sono stati impostati come Unproto Address. Più il pacchetto si 
allunga più aumenta il tempo di trasmissione, più aumenta la 
probabilità che venga corrotto perché altre stazioni nello stesso 
momento abbiano trasmesso. Inoltre si innesca un altro problema. 
Nell’invio dei messaggi se non si specifica quale digi utilizzare o di 
tenerli in ambito della propria portata radio (si veda paragrafo 4.3), il 
software UI-View utilizza quello che è stato impostato nell’Unproto 
Address. Ne consegue che se è stato impostato un eccessivo numero 
di ripetizioni i messaggi indirizzati ad un utente vicino e raggiungibile 
in diretta o con uno o due digi, vengono rimbalzati da molti digi 
creando una mole di traffico inutile, dannoso e assolutamente 
evitabile. Questo pessimo comportamento è la causa principale del 
cattivo funzionamento delle rete APRS. A sostegno di questo concetto 
ci sono molti altri esperti di APRS ben più autorevoli del sottoscritto. 
Prima di tutto il suo inventore Bob Bruninga che suggerisce un 
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indirizzamento non superiore a 3 ripetizioni. A dimostrazione di 
questo la Kenwood l’ha interpellato per il TM-D710 che usa di default 
3 ripetizioni. Secondo. L’ottimo sito di APRS “live” http://aprs.fi indica 
come “good path” le stazioni che indirizzano 3 o meno ripetizioni e 
“bad path” chi utilizza più di 4 ripetizioni motivando con le stesse mie 
argomentazioni. Infine ho saputo che l’Associazione Radioamatori 
della Danimarca indica come TRACE4-4 l’unproto address da 
utilizzare. E certamente non l’abbiamo concordato. 

 
 
2.6 In considerazione di quanto sopra ecco la tabella di 

configurazione di indirizzamento del beacon: 
 
Tipo di stazione Impostazioni UI-View Impostazioni RTX Kenwood 
Mobile/portatile APRS,RELAY,TRACE3-3 RELAY,TRACE3-3 
Fissa APRS,TRACE4-4 TRACE4-4 

  
2.7 E’ importantissimo che le stazioni fisse non indirizzino il 

proprio beacon a RELAY, questo dev’essere lasciato come 
punto di accesso alle stazioni mobili/portatili/QRP che hanno 
meno copertura radio e quindi necessitano di un punto 
intermedio per l’accesso ai digi ad ampia copertura. 
 

2.8 E’ ancora più da evitare l’invio del beacon a path multipli tipo 
RELAY,WIDE7-7,TRACE7-7. In questo modo le ripetizioni sono 
eccessive (nell’esempio 1+7+7=15). Così facendo si genera 
una quantità di ripetizioni tali da occupare eccessivamente la 
frequenza ottenendo come risultato di lasciare meno spazio 
alle altre stazioni. 
 

2.9 Di seguito la tabella su dove andare a mettere le precedenti 
impostazioni: 
 

Tipo di software o apparato Menu 
UI-View (stazione fissa) Setup -> Station setup -> Unproto address -> APRS,TRACE4-4 

Kenwood TM-D710 (fisso) Menu 612 -> TYPE: OTHERS -> TRACE4-4 
Kenwood TM-D700 (fisso) Menu 3-B Packet Path -> TRACE4-4 -> OK 
Kenwood TM-D710 (mobile) Menu 612 -> TYPE: OTHERS -> RELAY,TRACE3-3  
Kenwood TM-D700 (mobile) Menu 3-B Packet Path -> RELAY,TRACE3-3 -> OK 
Kenwood TH-D7 (fisso) Menu 2-8 Packet Path -> TRACE4-4 -> OK 
Kenwood TH-D7 (mobile) Menu 2-8 Packet Path -> RELAY,TRACE3-3 -> OK 
Kenwood TH-D7G2 (fisso) Menu 2-B Packet Path -> TRACE4-4 -> OK 
Kenwood TH-D7G2 (mobile) Menu 2-B Packet Path -> RELAY,TRACE3-3 -> OK 
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Come impostare l’indirizzamento dei pacchetti in UI-View 

 

 
 

Come impostare l’indirizzamento dei pacchetti sul TM-D710 
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Capitolo 3: caratteristiche del digipeater 
 
La catena dei digi è la struttura portante della rete APRS. Questi permettono 
ad un segnale anche minimo di coprire vaste aree locali. E’ evidente che le 
strategie da adottare per i digi devono essere accurate per fare in modo che 
tutto funzioni a dovere. La prima considerazione importante da fare è che i 
ripetitori digitali APRS si differenziano dai normali ripetitori analogici in fonia 
per diversi aspetti. Prima di tutto i digi APRS sono tutti non solo sulla stessa 
banda dei 2 metri, ma addirittura sulla stessa frequenza di 144.800 MHz a 
differenza dei ripetitori analogici fonia che vanno dai 29 MHz fino ai GHz. 
Inoltre i ripetitori analogici hanno toni sub-audio diversi che consentono un 
accesso selettivo mentre in APRS in linea di massima non possiamo stabilire a 
priori quale digi ripeterà il nostro segnale. Per questi motivi ed altri 
necessitano di una struttura di coordinamento più organizzata in modo da 
ottimizzare il loro funzionamento. 
Le caratteristiche a cui dovrebbe rispondere un digi APRS sono: 
 

1. Ottima copertura radio 
2. Presenza in aria costante 
3. Affidabilità 
4. Non vicinanza con altri digi 
5. Ubicazione in aree ad alta densità di utenti o in altura 
6. Possibilità di controllo da remoto e SysOp attento 
7. Coordinamento 

 
3.1 Copertura radio. E’ abbastanza evidente il significato, questa 

caratteristica e’ comune a qualsiasi tipo di ripetitore. Il fatto di 
essere in posizione strategica e quindi con buona copertura radio 
garantisce una buona diffusione del segnale. 

 
3.2 Presenza costante in frequenza. Purtroppo molto spesso si assiste 

all’attivazione di digi che dopo breve tempo spariscono. Questo per 
prove improvvisate o altri motivi. Questo comporta disfunzioni nella 
rete specialmente per quanto riguarda la pianificazione di altri digi. 
 

3.3 Affidabilità. Il criterio generale per l’approccio alla gestione di un 
ripetitore radioamatoriale dovrebbe essere di tipo professionale e 
cioè l’impianto deve essere realizzato con la massima cura tenendo 
presente che spesso si tratta di installazioni non presidiate e difficili 
da raggiungere. Un impianto eseguito con criteri professionali 
significa affidabilità nel tempo. 

 
3.4 Vicinanza con altri digi. Da evitare assolutamente l’installazione di 

digi in prossimità di altri. Digi vicini oltre ad essere inutili e dannosi, 
accorciano la distanza che un pacchetto APRS può percorrere in 
quanto scalano l’SSID in poca distanza (vedi punto 2.3). 

 
3.5 Ubicazione. E’ evidente che la scelta su dove installare un digi deve 

essere fatta anche in base alla quantità di utenti da servire e di 
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conseguenza la locazione dovrebbe essere scelta in base all’area più 
vasta possibile che il digi dovrebbe servire. 

 
3.6 Come al punto 3.3 ho accennato a criteri di professionalità 

nell’installazione, sarebbe auspicabile che il digi possa essere 
attivato e configurato da remoto in modo da poter variare la 
configurazione in qualsiasi momento. Inoltre la scelta del sysop 
(SYStem OPerator, colui che si occupa del funzionamento) dovrebbe 
essere fatta in base alle competenze, alla disponibilità e alla 
reperibilità del sysop. Sembra banale ma troppo spesso ci sono digi 
che sono installati, dimenticati e non si sa più chi e come li gestisce. 
Utile anche mettere nel beacon del digi il nome del SysOp in modo 
che chiunque possa avere un riferimento per segnalare eventuali 
problemi o malfunzionamenti. 

 
3.7 Coordinamento. E’ il punto più importante. La rete digi deve essere 

coordinata e organizzata. Un coordinatore nazionale dovrebbe 
tenere l’elenco dei digi, la loro ubicazione, l’area di copertura, i 
SysOp responsabili. Questo per ottimizzare la loro copertura. 
Sarebbe opportuno sfoltire dove ce ne sono troppi e metterne dove 
mancano. 

 
3.8 Una stazione normale non si deve assolutamente configurare 

come digi. Anche per fare delle prove. Questo per evitare 
tutti i problemi descritti in questo capitolo. Accertarsi quindi 
che nel menù di UI-View -> Setup –> Digipeater Setup non ci 
sia spuntata la casella Enable Digi. Non c’è nessuna 
sperimentazione nel configurare la propria stazione come 
digi ad alto livello. Non vedo quale sia la sperimentazione 
nello spuntare la casella “enable digi” e vedere che si è 
diventati un digi, è logico che funziona! L’unico effetto che si 
ottiene è quello di creare ulteriore caos a quello già 
esistente.  
 

 
 



 18

 
3.9 Ci sono però delle eccezioni che riguardano alcune stazioni 

normali configurate come digi RELAY. Chi ritiene di essere in 
una posizione strategica, buona copertura radio, 
sufficientemente lontano da digi ad alto livello e da altri 
eventuali digi Relay, chi ha una presenza costante in 
frequenza, chi abita in centri urbani medio/grandi dove è 
difficile per i mezzi mobili/portatili accedere ai digi ad alto 
livello, si può configurare come digi RELAY. Questo 
subordinato ai criteri di cui sopra, con l’identificazione del 
proprio digi (Setup -> Digipeater setup -> Alias substitution, 
proprio nominativo nel sub alias e impostare come sub 
aliases RELAY,PROPRIO_NOMINATIVO. 
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Capitolo 4: messaggi 
 
I messaggi in APRS sono uno strumento molto valido ma se usati male sono 
una delle principali cause dell’aumento sconsiderato e inutile del traffico in 
rete. Di seguito alcune norme di comportamento che si dovrebbero osservare 
per un utilizzo corretto. 
 

4.1 Non dimentichiamoci che siamo Radioamatori e quindi il contenuto 
delle conversazioni deve essere conforme al codice di 
regolamentazione delle comunicazioni radioamatoriali. I messaggi in 
APRS non devono essere una “chat” o peggio. Purtroppo si assiste 
già al penoso spettacolo dei ripetitori in fonia, qui non solo si rischia 
che il contenuto raggiunga tutto il mondo grazie ai server 
RF/internet ma rimane tutto scritto e memorizzato. 
 

4.2 Limitare le conversazioni allo stretto necessario che non giustifichi 
l’uso della fonia. Utilizzare la scrittura minuscola, il tutto maiuscolo 
equivale ad alzare il tono della voce e non sta bene. 
 

4.3 Prestare la massima attenzione al campo digi della finestra 
messaggi. Sull’argomento anni fa avevo già sottoposto il 
problema a Roger G4IDE ma purtroppo la malattia l’ha 
portato via prima che potesse modificare UI-View. Il fatto è 
questo: se non si specifica niente nel campo digi della 
finestra messaggi di UI-View il programma trasmette il 
messaggio utilizzando come path ciò che è stato impostato 
nell’unproto address (vedi punto 2.6). Quindi se 
trasmettiamo un messaggio alla stazione a pochi Km di 
distanza senza specificare niente del campo digi in effetti il 
nostro messaggio percorrerà tutta la rete digi e sarà visibile 
per una vasta area in RF e per tutto il mondo tramite 
internet. Cosa mettere allora nel campo digi? Prima di tutto 
se il destinatario dei messaggi è ricevuto in diretta (lo si 
vede nei dettagli della stazione nella finestra effective digi 
path che è vuota) nel campo digi della finestra messaggi 
dovrà essere scritto qualcosa che non sia un nome di un digi 
o un indirizzamento per i digi. Si potrebbe scrivere LCL, 
oppure 1, oppure LOCALE, oppure PIPPO eccetera; insomma 
qualsiasi cosa purché non venga lasciato il campo vuoto. Se 
invece la stazione destinataria del messaggio è ricevuta 
tramite la ripetizione di uno o più digi si digita il o i digi con 
cui è stata ricevuta nel campo digi della finestra messaggi. 
Da questo si capisce immediatamente la grande differenze 
fra WIDEn-n e TRACEn-n, col primo non sapremmo mai da 
quale digi abbiamo ricevuto una stazione con TRACEn-n si! 
Tutto questo vale solo per UI-View ovviamente. Per gli 
apparati dedicati Kenwood non è possibile. 
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Esempio della finestra messaggi per un utilizzo in ambito locale.



 21

Capitolo 5: varie 
 
Qui di seguito saranno elencati comportamenti vari che possono risultare 
dannosi per il buon funzionamento del sistema APRS. 
 
 Emergenze. Il trasmettere un segnale di emergenza senza che corrisponda 
al vero non solo è un comportamento irresponsabile a prescindere dall’APRS, 
ma attiva nei ricetrasmettitori dedicati Kenwood l’allarme emergenza che 
consiste nella scritta “EMERGENCY!” a tutto schermo e nell’emissione di 
segnali acustici. Questo è assolutamente da evitare, anche solo per fare delle 
prove. 
 
 Nominativi. Sembra assurdo ma mi trovo nella necessità di ricordare che 
ogni Radioamatore è in possesso di un nominativo radio rilasciato dal Ministero 
ed è quello che va usato. Identificativi come “CER”, “”ARIRE”; “PROCIV”, ed 
altri di questo genere sono FUORILEGGE! 
 
 Oggetti. Cosa sono ? Sono indicazioni virtuali che una stazione trasmette 
per segnalare qualcosa di rilevante e degno di importanza agli altri. Non sono 
stazioni vere. Si riconoscono perché il fondo della casella è azzurro. Qui si è 
visto di tutto e di più. Dalla fiera paesana al ristorante dell'amico passando per 
l'oggetto di se stessi posizionato nella stessa posizione della stazione. Sono 
assolutamente inutili!. La segnalazione di una sezione ARI può essere utile ma 
interessa solo localmente, quindi è da trasmettere solo in ambito locale senza 
interessare la rete di digi per la ripetizione. Per la segnalazione dei ripetitori 
sarebbe meglio creare degli overlays che la stazione interessata alla 
visualizzazione dei ripetitori si carica in loco senza trasmetterli in aria. 
Attenzione anche agli oggetti che indicano condizioni meteo. La segnalazione 
di un evento meteo particolare va bene ma deve essere fatta con attenzione e 
non dimenticata in trasmissione per ore o giorni anche quando l'evento è 
passato ma soprattutto la fonte delle informazioni deve essere sicura. Ad 
esempio una buona fonte di informazioni meteo potrebbero essere i Volmet 
aeronautici (Milano su 126.6 MHz). 
 
 Icone. L’icona è il primo colpo d’occhio che si ha su una stazione, la sua 
scelta deve rappresentare la caratteristica delle stazione e quindi corrispondere 
alla realtà. La classica casetta gialla per le stazioni normali va bene, se si è 
attivi anche in HF in APRS quella verde. 
 
 SSID. L’SSID (Station Supplementary IDentification) agli albori dell’APRS 
serviva ai primi programmi per APRS in DOS per assegnare l’icona alla 
stazione, ora non è più così ma gli SSID tornano utili per identificare alcune 
tipologie particolari di stazione o per distinguere stazioni diverse di uno stesso 
nominativo.  
 

SSID Identificazione Icona 
0 (nessun SSID) Stazione normale fissa  o  se in HF 
1 Consigliato per stazione secondaria   (a piedi) 
2 Consigliato per stazione secondaria  (zona lavoro) 
3 Stazione meteo  
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4   

5 Mezzi nautici  o  
6   

7 Consigliato per TCP  
8   

9 Mezzo mobile autovettura  
10 Mezzo mobile motocicletta  
11 Digipeater o Gateway TCP  /  o  
12 Jeep/SUV  
13 Camper  
14 Autocarro  o  
15 Furgone  
 

 Beacon Comment. Il Beacon Comment è una informazione trasmessa 
assieme al beacon il cui contenuto è un testo di campo libero. Per inserire le 
informazione del Beacon Comment bisogna selezionare il menu Setup poi 
Station Setup  e scrivere i dati nella casella Beacon Comment. Cosa è utile e 
cosa no. E’ utile scriverci il proprio nome e il QTH. E’ utile inserire anche la 
propria e-mail o la frequenza su cui si è QRV in fonia per indicare metodi per 
essere contattati alternativi all’APRS. Cosa non è utile. E’ assolutamente inutile 
scriverci il nominativo in quanto è già trasmesso automaticamente e sarebbe 
quindi una informazione doppia. Il nominativo si vede già nell'icona. Evitare 
caratteri inutili come punti, asterischi e lineette a gogò. Oltre a trasmettere 
dati assolutamente inutili che contribuiscono solo ad allungare i pacchetti, i 
TH-D7 ed i TM-D700 non visualizzerebbero l’informazione in quanto hanno una 
capacità limitata del display a rispettivamente 25 e 28 caratteri perciò se 
iniziamo il Beacon Comment con una serie di asterischi chi riceve con tali 
apparati vede solo quelli e non l’informazione utile. Ribadisco di scrivere 
minuscolo, il maiuscolo significa alzare il tono della voce e questo non è bello. 
 
 Gateway Internet/RF. Molto bene ovviamente prendere i dati radio per 
immetterli nella rete internet ma attenzione al contrario, se non si attivano i 
dovuti filtri si rischia di immettere nella rete RF un’eccessiva quantità di dati. 
Con la diffusione sempre più capillare dell’accesso ad internet in condizioni di 
portabilità (computer portatili e pocket pc), il poter accedere ad un server 
locale per vedere ed interagire col traffico APRS locale è diventato uno 
strumento fenomenale per l’APRS.  
 
 Bollettini. Un altro ottimo strumento di diffusione di massa di notizie usato 
spesso male. I bollettini servono a comunicare a tutti gli utenti avvenimenti 
importanti che richiedono attenzione. Le situazioni di routine possono essere 
segnalate nel Beacon Comment o nello Status Text. 
 
 Esercitazioni di Protezione Civile e manifestazioni. L’APRS trova il suo 
ambiente di applicazione naturale nelle esercitazioni di Protezione Civile e nelle 
manifestazioni a cui i radioamatori partecipano. Non solo per gli aspetti tecnici 
ma anche per l’ottimo impatto visivo e di immediata comprensione anche ai 
non addetti ai lavori. Purtroppo è sempre molto frequente vedere sulla rete 
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internazionale APRS (144.800 MHz) la presenza di questo tipo di attività che 
crea molti problemi al traffico normale. E’ fortemente consigliato che in 
occasione di questo tipo di attività la frequenza di utilizzo non sia quella 
normalmente usata (144.800) ma sia una frequenza packet in VHF o UHF in 
accordo col band plan. I motivi sono due. Primo. In occasione di esercitazioni 
di Protezione Civile o eventi sportivi si ha la necessità di trasmettere una 
grande quantità di dati ed i mezzi mobili di aggiornare frequentemente la loro 
posizione, ne consegue che si riversa sulla 144.800 una enorme quantità di 
dati che a tutti gli altri utenti non interessa e intasa inutilmente la frequenza. 
Secondo. Nelle suddette occasioni non interessa il traffico degli utenti della 
rete normale e quindi le stazioni interessate alla esercitazione o alla 
manifestazione si vedrebbero arrivare una gran quantità di traffico che oltre ad 
essere inutile, metterebbe in difficoltà il traffico veramente necessario. 
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Conclusioni 
 
Questi sono esempi della validità e della potenzialità dell'APRS. Concludo 
affermando che tutto questo non è la soluzione magica a tutti i problemi della 
rete APRS, sono semplici osservazioni fatte da chi è in continua attività dal 
dicembre 1999, ha raccolto i pareri di chi è attivo e fattivo in APRS da tempo e 
ha passato tanto tempo in monitor. 
Se qualcuno ha dei consigli o correzioni da apportare sarò felice di integrarle in 
questo scritto che ha come unico obiettivo quello di far funzionare al meglio la 
rete APRS. 
 
L’APRS ha delle potenzialità incredibili, specialmente nelle applicazioni della 
Protezioni Civile. Molte di queste potenzialità non sono state descritte qui per  
semplicità, purtroppo spesso è usato male per non conoscenza delle regole, o 
peggio, per spregio. Inoltre è accessibile a chiunque anche con pochi mezzi, 
quasi tutti hanno in casa un computer ed una RTX FM in 2 metri. 
 
L’APRS è una tecnologia dalle grandi applicazioni se usato adeguatamente, non 
facciamolo diventare un giochino stupido! 
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